Advanced Automated Test Development with TUX

In this tutorial, you will learn how to effectively create test modules that can be run by the TUX harness to generate effective white box tests for their software solution. This tutorial includes a suite of tests for a sample Windows CE stream driver module, and presents guidelines and best practices for writing a TUX test suite to thoroughly test functionality in Windows CE modules.
1. Create the platform:
a. In Platform Builder, on the File menu, click New Platform.

b. Click Next in the wizard.
c. Type a name for the platform in the Name box (for example, type TuxPlat), choose a location for the file, and click Next.
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d. Click Emulator: x86 in the Available BSPs list, and then click Next.
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e. In the New Platform Wizard - Step 4 box, choose a design template. In this tutorial, we will use Internet Appliance template, but you can use any template.

f. In step 5 and step 6 of the wizard, add or remove the components that you want to use.
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g. After you select the components that you want to use, click Finish to complete the wizard.

2. Add the Sample Stream driver to the project:
h. On the File menu, click New Project or File.
i.  Click WCE Dynamic-Link Library, type a name for the library in the Project Name box, choose a location for the file, and then click OK.
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j. In step one of the wizard, type information in the boxes, and then click Next. 
Note that you can type as much or as little information as you want in the boxes.
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k. In step 2 of the wizard, click A simple Windows CE DLL project, and then click Finish.
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l. After you complete the previous steps, the .dll file contains only an empty DllMain function. In the next steps, you will use the Windows CE Driver Wizard that was written by Mike Hall to create a skeleton stream driver.
In Windows CE, you open stream drivers just like you open files by using a unique, three letter prefix (for example, COM). Type a unique, three letter identifier for your driver in the Driver Name "XXX" box. In the Location box, either type the full path to the stream driver that you chose in step 2.a., or navigate to the PBWorkspaces folder in your Platform Builder installation to find the platform that you created (in our example, this is PBWorkspaces\TuxPlat\StreamDrv). Type StreamDrv as the name for the stream driver in the Driver Filename box to ensure that the original file that was created in Platform Builder is overwritten, and then click Go to generate the stream driver source.
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3. Basic TUX - create a skeleton TUX module:
m. On the File menu, click New Project or File.
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n. Click WCE TUX Dynamic-Link Library, type a project name, choose a location for the project, click Workspace Project, and then click OK.
Note that you can choose either project type. In this tutorial, however, we will use the Workspace project)

o. In step one of the wizard, type information in the boxes, and then click Next. 

Note that you can type as much or as little information as you want in the boxes.
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p. Read the information in step 3 of the wizard, and then click Next.
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q. In step 3 of the wizard, you can click CETK in the Release Type box. If you click CETK, optimizations for retail binaries are turned off to increase debugging productivity. Click Finish.
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r. On the View menu, click File View, and then click to expand Projects to display the TUX source.
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The important files to note under Projects are:

· Ft.h – this file contains the function table that is used by the TUX .dll file.
· Test.cpp – this file contains the test procedures that are called from the function table.

· TuxStreamTest.cpp – this file contains DLLMain, and ShellProc (which is called from Tux.exe).

4. In the next steps, you will learn how to write some tests:
s. Open the Ft.h file, and then replace the entire function table (FTE) with the following function table:

// prototypes for helper functions

DWORD TuxActivateDevice(LPHANDLE lpDriver);

DWORD TuxDeactivateDevice(HANDLE hDriver);

BEGIN_FTE

    FTH(0, "Sample stream driver basic functionality test cases")

        FTE(1,      "Register / Deregister Device Test", 1, 0, ActivateDeviceTest)

        FTE(1,      "Open driver for stream access", 2, 0, LoadUnload)

    FTH(0, "Sample stream input validation tests")

        FTE(1, "Test Ioctls", 10, 0, TestIoctl)    

    FTH(0, "Sample stream driver stress tests")

        FTE(1, "10 Loads and Unloads", 20, 100, LoadUnload)

       //FTE(1, "50 Loads and Unloads", 21, 50, LoadUnload)

    FTH(0, "Sample stream driver read / write tests")

        FTE(1, "Simple Read Write", 30, 0, SimpleReadWriteTest)

    FTH(0, "Sample stream driver custom function tests")

        FTE(1, "Custom Function Tests", 40, 0, CustomFunctionTest)

    FTH(0, "Sample stream driver security tests")

          FTE(1, "Security Test", 50, 0, SecurityTest)

    FTH(0, "Sample stream driver performance tests")

          FTE(1, "Performance Test", 60, 0, PerformanceTest)

END_FTE 
t. Open the Test.cpp file, and then add the following functions and function stubs below the TestProc function:

TESTPROCAPI ActivateDeviceTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{


return TPR_SKIP;

}

// Open and close the file for access through createfile.

// This function uses a value that is passed through TPPARAM

// to determine how many times to do this action

TESTPROCAPI LoadUnload(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

// Functional test for return values on ReadFile and WriteFile

TESTPROCAPI SimpleReadWriteTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

// Test the IOCTL values that are exposed by the driver

TESTPROCAPI TestIoctl(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

// You can also call exported functions in a driver .dll file by

// either linking with an import library or by using GetProcAddress to

// gain access
TESTPROCAPI CustomFunctionTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

// The prototype for this function in the driver is BOOL 

// CustomFunctionEx(LPTSTR); 

// A buffer without a length check is a good candidate

// for a security issue. In a white box scenario, you do not
// know what the driver is doing. Because of this, it is a good test case

// to call this function with some longer buffers

TESTPROCAPI SecurityTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

#define MARK_TEST           0

TESTPROCAPI PerformanceTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    return TPR_SKIP;

}

// Helper functions

DWORD TuxActivateDevice(LPHANDLE lpDriver)

{

    DWORD tprResult = TPR_PASS;

    //*lpDriver = RegisterDevice(_T("DEM"), 1, _T("StreamDrv.dll"), 0);

    *lpDriver = ActivateDeviceEx(_T("Drivers\\BuiltIn\\StreamDrv"), 0,0,0);

    if (INVALID_HANDLE_VALUE == *lpDriver || NULL == *lpDriver)

    {

        tprResult = TPR_FAIL;

    }    

    return tprResult;

}

DWORD TuxDeactivateDevice(HANDLE hDriver)

{

    DWORD tprResult = TPR_PASS;

    //if (FALSE == DeregisterDevice(hDriver))

    if (FALSE == DeactivateDevice(hDriver))

    {

        tprResult = TPR_FAIL;

    }

    CloseHandle(hDriver);

    return tprResult;

}

u. The first type of tests that are addressed in this tutorial are basic tests that you can use to verify that the driver can both be loaded by the system and opened for stream access. This basic verification is done by using the ActivateDeviceTest and LoadUnload functions:

TESTPROCAPI ActivateDeviceTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    HANDLE  hDriver = INVALID_HANDLE_VALUE;

    DWORD tprResult = TPR_PASS;

    // The shell does not necessarily want us to execute the test. Make sure first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    // Verify that the driver can be activated and deactivated

    if (TPR_FAIL == TuxActivateDevice(&hDriver))

    {

        g_pKato->Log(LOG_FAIL, TEXT("ActivateDevice failed for StreamDrv."));

        tprResult = TPR_FAIL;

    }    

    else

    {

        if (TPR_FAIL == TuxDeactivateDevice(hDriver))

        {

            g_pKato->Log(LOG_FAIL, TEXT("DeactivateDevice failed for StreamDrv."));

            tprResult = TPR_FAIL;

        }

    }

    if (TPR_PASS == tprResult)

    {

        g_pKato->Log(LOG_PASS, TEXT("Successfully activated and deactivated stream driver."));

    }

    return tprResult;

}

// Open and close the file for access through createfile.

// This function uses a value that is passed through TPPARAM

// to determine how many times to do this action

TESTPROCAPI LoadUnload(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    HANDLE hDriver = INVALID_HANDLE_VALUE;

    DWORD tprResult = TPR_FAIL;

    // The shell doesn't necessarily want us to execute the test. Make sure     first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    UINT loopCount = (UINT)lpFTE->dwUserData;

    for (UINT i = 0; i <= loopCount; i++)

    {

        hDriver = CreateFile( _T("DEM1:"),  0, 0, NULL,  OPEN_EXISTING, 0, NULL );

        if (INVALID_HANDLE_VALUE == hDriver)

        {

            g_pKato->Log(LOG_FAIL, TEXT("Failed to open stream driver DEM1: on iteration %u"), i);

        }

        else

        {

            if (FALSE == CloseHandle(hDriver))

            {

                g_pKato->Log(LOG_FAIL, TEXT("failed to close stream driver DEM1: on iteration %u"), i);

            }    

            else

            {

                g_pKato->Log(LOG_PASS, TEXT("Successfully opened and closed stream driver."));

                tprResult = TPR_PASS;

            }

        }    

        if(TPR_PASS != tprResult) break;

    }

    return tprResult;

}

v. Most of the functionality of stream drivers is performed through read and write functions. Generally, you will read or write data to the driver and verify that the functions were successful. For this “empty” driver, the following code will verify that ReadFile and WriteFile succeed:

// Functional test for return values on ReadFile and WriteFile

TESTPROCAPI SimpleReadWriteTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    HANDLE hDriver = INVALID_HANDLE_VALUE;

    DWORD tprResult = TPR_PASS;

    TCHAR bufferIn[256], bufferOut[256];

    DWORD dwBytesWritten = 0, dwBytesRead = 0;

    // The shell does not necessarily want us to execute the test. Make sure first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    StringCchCopy(bufferIn, 256, _T("This is test data - I could fill the buffer to be interesting"));

    hDriver = CreateFile( _T("DEM1:"),  0, 0, NULL,  OPEN_EXISTING, 0, NULL );

    if (!WriteFile(hDriver, bufferIn, 256 * sizeof(TCHAR), &dwBytesWritten, NULL))

    {

        g_pKato->Log(LOG_FAIL, TEXT("Write failure in ReadWriteTest"));

        tprResult = TPR_FAIL;

    }

    else

    {

        if (!ReadFile(hDriver, bufferOut, 256 * sizeof(TCHAR), &dwBytesRead, NULL))

        {

            g_pKato->Log(LOG_FAIL, TEXT("ReadFile failure in ReadWriteTest"));

            tprResult = TPR_FAIL;

        }

     }       

    CloseHandle(hDriver);

    if (dwBytesRead != dwBytesWritten)

    {

        g_pKato->Log(LOG_FAIL, TEXT("Bytes read different than Bytes Written (%d to %d"), dwBytesRead, dwBytesWritten);

        tprResult = TPR_FAIL;

    }

    if (tprResult == TPR_PASS)

    {

        g_pKato->Log(LOG_PASS, TEXT("Simple ReadWriteTest succeeded"));

    }        

    return tprResult;

}

w. Drivers often expose functionality through IOCTLs, which are accessible through the DeviceIoControl function. This sample driver supports only one IOCTL, which reverses a string. To test this function, the following code reverses the string twice, and then verifies that it matches the original string.
// Test the IOCTL values that are exposed by the driver

TESTPROCAPI TestIoctl(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    HANDLE hDriver = INVALID_HANDLE_VALUE;

    DWORD tprResult = TPR_PASS;

    TCHAR bufferIn[256];

    TCHAR bufferOut[256];

    DWORD dwBytesWritten = 0;

    // The shell does not necessarily want us to execute the test. Make sure first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    // NOTE - the following IOCTL definitions would be typically obtained

    // by including a common header - the public headers for

    // the driver or module under test

    #define IOCTL_DRIVER_REVSTR 0x1000

    #define IOCTL_DRIVER_SETVAL 0x1001

    #define IOCTL_DRIVER_GETVAL 0x1002

    hDriver = CreateFile( _T("DEM1:"),  0, 0, NULL,  OPEN_EXISTING, 0, NULL );

    StringCchCopy(bufferIn, 256, _T("abc"));

    DWORD dwSize = (_tcslen(bufferIn) + 1) * sizeof(TCHAR);

    if (FALSE == DeviceIoControl(hDriver, 

                                                IOCTL_DRIVER_REVSTR,

                                                bufferIn, 

                                                dwSize, 

                                                bufferOut, 

                                                dwSize, 

                                                &dwBytesWritten, 

                                                NULL))

    {

        g_pKato->Log(LOG_FAIL, TEXT("DeviceIoControl failed"));

        tprResult = TPR_FAIL;

    }    

    else

    {

        g_pKato->Log(LOG_COMMENT, TEXT("Reversed strings is %ls"), bufferOut);

        // One way to test whether revstr worked would be to call it again

        // and then see if the strings match

        TCHAR bufferOut2[256];

        DeviceIoControl(hDriver, 

                                IOCTL_DRIVER_REVSTR,

                                bufferOut, 

                                dwSize, 

                                bufferOut2, 

                                dwSize, 

                                &dwBytesWritten, 

                                NULL);

        // remember that strcmp returns non-zero

        // if the strings do not match.

        if (_tcscmp(bufferIn, bufferOut2))

        {

            g_pKato->Log(LOG_FAIL, TEXT("Reversed strings do not match - %ls, %ls"), bufferOut, bufferOut2);

            tprResult = TPR_FAIL;

        }    

    }

    CloseHandle(hDriver);

    if (tprResult == TPR_PASS)

    {

        g_pKato->Log(LOG_PASS, TEXT("Simple IOCTL test succeeded"));

    }        

    return tprResult;

}

x. Drivers (and other modules) can also expose functionality through exported functions. For this test, the following code gains access to these functions by using GetProcAddress, and then calls them by using function pointers:
// It is also possible to call exported functions in a driver dll by

// either linking with an import lib or using GetProcAddress to

// gain access.

TESTPROCAPI CustomFunctionTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    DWORD tprResult = TPR_PASS;

    typedef BOOL     (WINAPI *PFNCUSTOMFUNCTION)(void);

    typedef BOOL     (WINAPI *PFNCUSTOMFUNCTIONEX)(LPTSTR);

    // The shell does not necessarily want us to execute the test. Make sure first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    PFNCUSTOMFUNCTION pfnCustomFunction = NULL;

    PFNCUSTOMFUNCTIONEX pfnCustomFunctionEx = NULL;

    HMODULE hInstDriver=LoadLibrary(_T("streamdrv.dll"));

    if (NULL != hInstDriver) 

    {

        g_pKato->Log(LOG_COMMENT, TEXT("Driver can be called directly!"));

        pfnCustomFunction =  (PFNCUSTOMFUNCTION) GetProcAddress(hInstDriver, _T("CustomFunction"));

        pfnCustomFunctionEx = (PFNCUSTOMFUNCTIONEX) GetProcAddress(hInstDriver, _T("CustomFunctionEx"));

    }

    if (pfnCustomFunction)

    {

        (BOOL )pfnCustomFunction();

    }

    if (pfnCustomFunctionEx)

    {

        LPTSTR lpHello = _T("Hello");

        (BOOL )pfnCustomFunctionEx(lpHello);

    }

    FreeLibrary(hInstDriver);

    return tprResult;

}

y. There are many methods for writing performance tests. The GetTickCount and QueryPerformanceCounter functions are often used to time various functions and operations. The Windows CE Test Kit (CETK) includes a performance logging library, called perflog. Perflog automatically calibrates itself to adjust for the speed of the system and function call overhead, and has proven to be very accurate. In this example, the sample driver does not do very much, so the timings do not tell us much (also note that any timings that include debug output are rarely accurate). The following code demonstrates how to use perflog. 

This function also demonstrates how to use the –c option to pass a command line to a TUX dll.
#include perflogger.api // link to perflog.lib

#define MARK_TEST           0

TESTPROCAPI PerformanceTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    DWORD dwBytesWritten = 0, dwBytesRead = 0;

    HANDLE hDriver = CreateFile( _T("DEM1:"),  0, 0, NULL,  OPEN_EXISTING, 0, NULL );

    UINT cbBufSize;

    // The shell does not necessarily want us to execute the test. Make sure first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    // Pass command lines to a TUX dll by using the -c parameter,
    // for example, tux -o -d tuxstream.dll -c7

    // NOTE: the dll receives the command line as a string

    UINT loopCount = _ttoi(g_pShellInfo->szDllCmdLine);

    if (loopCount <=0) 

    {

        loopCount = 100;

    }

    // This tutorial will now show you how to time how long it takes to read and   

    // write various amounts of data times.
    // In our dummy driver, this is not very exciting,

    // but on real hardware, it may be interesting and can be used to

    // find the best place for data transfer rates.

    // Note that you can determine what the acceptable

    // time is for this action. The time is dependent on specifications and

    // customer data.
    for (UINT i = 1; i <= 16; i++)

    {

        cbBufSize = (UINT)pow(i, 3);

        Perf_RegisterMark(MARK_TEST, _T("Testing %d byte allocations"), cbBufSize);

        // create a few buffers - initialize them

        BYTE *pbBufIn = new BYTE[cbBufSize];

        memset(pbBufIn, 0xFF, cbBufSize);

        BYTE *pbBufOut = new BYTE[cbBufSize];

        memset(pbBufOut, 0x00, cbBufSize);

        Perf_MarkBegin(MARK_TEST);

        for (UINT j = 0; j < loopCount; j++)

        {

            WriteFile(hDriver, pbBufIn, cbBufSize, &dwBytesWritten, NULL);

            ReadFile(hDriver, pbBufOut, cbBufSize, &dwBytesRead, NULL);

        }

        Perf_MarkEnd(MARK_TEST);

        delete[] pbBufIn;

        delete[] pbBufOut;

    }

    CloseHandle(hDriver);

    return TPR_PASS;

}

z. The most common type of security issue is a buffer overrun. If a module uses an unchecked stack buffer, it is very susceptible to security attacks. The following code attempts to overwrite the buffer:

// The prototype for this function in the driver is BOOL 

// CustomFunctionEx(LPTSTR); 

// A buffer without a length check is a candidate

// for a security issue. In a white box scenario, you do not
// know what the driver is doing, so it is a good test case

// to call this function with some longer buffers

TESTPROCAPI SecurityTest(UINT uMsg, TPPARAM tpParam, LPFUNCTION_TABLE_ENTRY lpFTE)

{

    DWORD tprResult = TPR_PASS;

    typedef BOOL     (WINAPI *PFNCUSTOMFUNCTIONEX)(LPTSTR);

    // The shell doesn't necessarily want us to execute the test. Make sure     first

    if(uMsg != TPM_EXECUTE)

    {

        return TPR_NOT_HANDLED;

    }

    PFNCUSTOMFUNCTIONEX pfnCustomFunctionEx = NULL;

    HMODULE hInstDriver=LoadLibrary(_T("streamdrv.dll"));

    if (NULL != hInstDriver) 

    {

        pfnCustomFunctionEx = (PFNCUSTOMFUNCTIONEX) GetProcAddress(hInstDriver, _T("CustomFunctionEx"));

    }

    if (pfnCustomFunctionEx)

    {

        // Expand this string to cause a potential stack overflow
        LPTSTR lpHello = _T("placeholder");

        (BOOL )pfnCustomFunctionEx(lpHello);

    }

    FreeLibrary(hInstDriver);

    return tprResult;

}
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